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We will go over the Phased Array Antenna example

e Available in VSim10
* |[n Documentation

[ Phased Array (phasedArrayAnts: X | + - 2 %
¢« O @ @ File | C/Program%20Files/Tech-X/VSim-11.00... ¥ ¥ 2

VSim Documentation 11.0.0dev-r2810  Tech-X Index Documents ~  Current Topic ~

VSim Customization

VSim Reference

Phased Array (phasedArrayAntenna.sdf)
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Problem Description

This VSImEM example illustrates how to setup a phased array simulation and analyze the far field results. Phased
array antennas are a vastiy-expanding field of research and development due to the fact that going from a one
element antenna to an N-element antenna provides more directive beamforming characteristics and, most
importantly, non-mechanical steering. Creating a multiple-element antenna results in an array pattem composed of
wires, apertures, or other element types. Directive pattemns are obtained via constructive interference in the desired
direction and destructive in the other directions. Applications of phased array antennas range from commercial (5G
wireless & mobile, satellite telecommunication), military & defense (RADAR, acoustics) to research: atmospheric,
space.

This simulation can be run with a VSImEM license

Opening the Simulation
The phasedArrayAntenna example is accessed from within VSimComposer by the following actions
« Select the New — From Example... menu item in the File menu.

© Copyright 2012-2019, Tech-X Corporation

Examples

—Available Templates

+- V/Sim for Basic Physics
= VSim for Electromagnetics
= Antennas
- 2.4 GHz Yagi Uda Antenna
- Antenna Array 2D
-~ Antenna on Human Hand with Dielectric
- Loop Antenna From a Coaxial Cable
- Dipole Antenna
-~ Dipole Above Conducting Plane
- Dish Antenna
- Half-Wave Dipole in Free Space
- Horn Antenna
- Patch Antenna Far Field

- Antenna on Predator Drone
i Electrostatics

+- Photonics

v Photonics (text-based setup)
+- Scattering
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- Scattering (text-based setup)
- Other EM

- Other EM (text-based setup)
F-VSim for Microwave Devices
+-V3im for Plasma Acceleration

1l VWQim fr Dlacma NMicrharnoac

I+

3l

e Phased Array Antenna

Description

Simulation of a planar phased array with 3D
steering.
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Geometry Construction

* Uses the “Create Array” option on an existing primitive shape to
duplicate the shape with regular spacing.

Wivsim

File Edit Tools View Help

*ysim.sdf

Simulation
Description

* Constants
Parameters
Basic Settings
Functions
SpaceTimeFunctions
Materials

= Geometries

[Aeylinderd
CAD
Meshes
- Grids
«[JaGrid
* Field Dynamics
Histories

Property
kind

material
length

radius

X position

¥ position

z position

axis direction x
axis direction y
axis direction z
color

3D View

Database

%y,Z (z,1,phi)

x Array Description

[ ] Union Created Shapes

NX: |5 NY: 4

4 |bov 4

4Setup: SIMULATION SETUP CHANGED Save the setup for simulation ¢

es to take effect

# Simulation Has Changed. Save and Setup

Perspective View | +z - Reset Position

Whvsim

File Edit Tools View Help

*ysim,.sdf
Simulation
Description
* Constants
Parameters
Basic Settings
Functions
SpaceTimeFunctions
Materials
= Geometries
= cse
Oeylindero
“[A cylinderoArray
[AeylinderOElem
[ cylinderOElemd
[ eylinder0Elem1
[AcylinderOElem2
[ cylinderoElem3

Property
kind
material
length
radius
¥ position
y position
z position
axis direction x
axis direction y
axis direction z
color

Undo

Add Multiple Remoave

Value

Cylinder

+Setup: SIMULATION SETUP CHANGED Save the setup for simu

3D View

Database

+ Simulation Has Changed. Save and Setup

Perspective View | +2 ©  Reset Position




Our Example

VSirn - Phased Array Antenna - [m] X

File Edit Tools View Help Window

& Simulation Setup is Ready Save and Setup

x,v,2(z,,phi) Properties IVlew Solids ¥ | Edit Mode IToggIe Axes IPerspecﬁve View ShowScale | Clip ||+z _¥| ResetPosition

e 15 x 15 array of
short cylinders

phasedArrayAntenna.sdf | phasedArrayAntenna.pre ] phasedArrayAntenna.in |
Simlation |«]
currFunc
thetaFunc _]
[=] SpaceTimeFunctions
currSTF
[+] Materials
[=] Geometries
[=] M cs6
M cylinderd
[=] cylinderDArray
O cylinderOElem
O cylinderOElem0
O cylinder0Elem1
O cylinder0Elem2
O cylinder0Elem3
O cylinderOElem4
O cylinder0Elem5
O cylinderOElem6 ﬂ

Add Multinlnl Remaove |

| Materials Database | 30 View

* Assigned PEC
material

Undo
Add Primitive *
Property | Value
kind Construction Group
relative tessellation 0.01

@ setup: COMPLETED Click run to continue Show Log




Boundary Conditions on 6 Sides

* 5 Open Boundaries

* Takes up no space.

 Thick MAL’s would be
better, if you can
afford the mesh.

* 1 PEC Boundary

* Infinite Ground Plane
* (does not display)

mVSim - Phased Array Antenna
File Edit Tools View Help

phasedArrayAntenna.sdf phasedArrayAntenna.pre phasedArrayAntenna.in

H | Simulation

* Geometries
Meshes
= Grids
=[] Grid
7 = Field Dynamics
“ Fields

openUpperX
openLowerX
openUpperY
openLowerY
openUpperZ
;pecLowerZ
= CurrentDistributions
[]generalDistributedCurrent
RCSBox
“ Histories
[ farFieldBox

Property
kind

description
boundary surface

Undo Add Multiple Remove

Value

Perfect Electric Conductor

lower z

Add

3D View

Database

xl 'IZ (Zf ’phl)

Properties

View |



Source drives current from ground plane to radiating elements

mVSirn - Phased Array Antenna - O X
File Edit Tools View Help

@ Simulation Setup is Ready Save and Setup

 Single source, the
entire slab volume
between the ground g
plane and the
elements

phasedArrayAntenna.sdf phasedArrayAntenna.pre phasedArrayAntenna.in

etup | simulation %y,2 (2,7,phi) Properties View Solids - Select Solid -l Toggle Axes Perspective View | +z - Reset Position

Description
“ Constants.
“ Parameters
Basic Settings
* Functions
* SpaceTimeFunctions
* Materials

3D View

Database

¥ Geometries
Meshes
* Grids
= Field Dynamics
“ Fields
“ FieldBoundaryConditions
= CurrentDistributions
[“IgeneralDistributedCurrent

RCSBox
. . * Histories
* Will use a functional _
Undo Add Multiple Remove Add
“mask” to restrict ooy
kind General Distributed Current
description
current to each e o
- J2(x, v, z, t) currSTF l
Cy I I n d e r E volur.ne cartesian 3d slab
xMin -0.36
xMax 0.36
yMin -0.36
yMax 0.36
zMin -0.008
zMax 0.008

e Jz = currSTF(x,y,t)

@Setup: COMPLETED Click run to continue Show Log




Hardest Part of This Example: All The Functions

* dphiFunc
* ampFunc
* PhiFunc

* xXMask

* yMask

* currkFunc
* thetaFunc
* currSTF

VSim - Phased Array Antenna
File Edit Tools View Help Window

phasedArrayAntenna. sdf | phasedArrayAntenna.pre I phasedArrayAntenna.in |

Simulation lﬂ

Description
[*] Constants
[*] Parameters

f [=] Functions \

dphiFunc
ampFunc
PhiFunc
xMask —
yMask
currFunc
thetaFunc

[=] SpaceTimeFunctipns

[+] Materials
[*] Geometries
[+] Grids |

Undo |Add Multiple| Remove| Add ‘

Property | Value I

kind expression
description Expression
expression currFunc(x,y,t)

| Materials Database I 3D \View

X,v,Z (z,r,phi) Properties ||View Sol

'
‘!
' '

vy
'



Functions at First Glance: A Lot to Digest

currSTF = currFunc(x,y,t)
currFunc(x,y,t) = ampFunc(x,y,t) * sin(PhiFunc(x,y,t)) * xMask(x) * yMask(y)

xMask(x) = H(sin(TWOPI*x/SPACING) - 0.9)
yMask(y) = H(sin(TWOPI*y/SPACING) - 0.9)

dphiFunc(t) = PI/4
thetaFunc(t) = TWOPI*t/T_OFF

PhiFunc(x,y,t) = OMEGA*t + (OMEGA/LIGHTSPEED) * sin(dphiFunc(t)) *
(x*cos(thetaFunc(t)) + y*sin(thetaFunc(t)))

ampFunc(x,y,t) = AMP_GAUSS*exp( ((-1.)/(2*SIGSQR)) *
( sin(dphiFunc(t)))*2 * ( x*sin(thetaFunc(t)) - y*cos(thetaFunc(t)) )2
+ cos(dphiFunc(t))?*2 * (x*2 +y*2) )



Functions Part 1: Plane Wave Phasing

e currFunc(x,y,t) = ampFunc(x,y,t) * sin(PhiFunc(x,y,t)) * xMask(x) * yMask(y)
e Thisis just:  Amplitude * sin(ot+k.r) * Mask

* This is the basic starting point for any phased array, the elements are
simply driven with phase of a plane wave, having vector wavenumber, k.

* More advanced corrections can help with side lobes.



Functions Part 2: Masking to the elements

David N. Smithe @ B — 0O X

* Heaviside function of offset sine = SesnetC e

Insert  Draw  Page Layout  Formulas  Data  Review  View  Developer  Help Q Tellme S Share
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Functions Part 3: Plane Wave Phase

* Wavenumber, k, is described by the elevation angle, ¢, and the
azimuthal angle, ©O.

* In this simulation, 6(t), and ¢ fixed, e.g., beam rotates in time.

k = (w/c){e, cosO sing + e, sin0 sind + e, cosd }
¢: dphiFunc(t) = PI/4
0: thetaFunc(t) = TWOPI*t/T_OFF

ot+kx
PhiFunc(x,y,t) = OMEGA*t + (OMEGA/LIGHTSPEED) * sin(dphiFunc(t)) *
(x*cos(thetaFunc(t)) + y*sin(thetaFunc(t)))



Functions Part 4: Amplitude

e 1D Gaussian perpendicular to k ... times 2D Gaussian on array plane.

(for low angles) (for high angles)

Amplitude: Aexp(-{|(exe.) r|?+ |(e. e)r|?}/c?)

ampFunc(x,y,t) = AMP_GAUSS*exp( ((-1.)/(2*SIGSQR)) *
( sin(dphiFunc(t)))*2 * ( x*sin(thetaFunc(t)) - y*cos(thetaFunc(t)) )*2
+ cos(dphiFunc(t))*2 * (x*2 + y*2) )



1 - Phased Array Antenna

dit Tools View Help Window

phasedArrayAntenna. sdf | phasedArrayAntenna.pre ] phasedArrayAntenna.in |

Far Field Box History

Simulation I X,v,Z (z,r ,phi) Properties

Description
[+] Constants

* Box surrounds the radiating elements. | (B,

Basic Settings
[+ Functions
[*] SpaceTimeFunctions

* Used in conjunction with Analyzer Tab < Vi

[+] Geometries
[+] Grids

* ComputeFarFieldFromKirchhoffBox Srem

e Kirchhoff Theorem

2. THEORY AND ALGORITHM

2.1. Kirchhoff Integral Theorem. The Kirchhoff integral representation relates the elec- Undo | Add Multiple | Remove | Add |
tric and magnetic fields in a bounded volume devoid of charges and currents to an integral

-

| Materials Database I 3D View

of the fields over the boundary surface [1]. For any field x(a,t) that is a solution to I I
the homogeneous wave equation and Green function G(x, ¢, 2', t') the Kirchhoff formula Property Value
asserts kind Far-Field Box Data
1 [ description
x(z,t) = 4—[ cdt’ / dS GH(x,t, 2 1) start time 0.0
T 0 v end time T_OFF
. (18 1 'y [=] volume cartesian 3d slab
" [\7 ! (caf' )@ *xMin -0.36
. o e xMax 0.36
(with r = & — ') so long as x and G satisfy e 0.36
v 13_? x(x, 1) _ 0 yMax 0.36
292 ) Glot,x' ) —5(x—a)s(t—t) zMin 0.01
) zMax 0.2

over the bounded volume V. For an initial value problem the retarded Green function

GHz, b2 l) = Sle(t — ') — |z —a|]6(t —t)

|z — |
is nonzero only on the past light cone, G* = 0 for ¢’ = ¢, so that the upper limit of the
time integral is ffx

'A virtual surface need not and typically will not coincide with a physical surface or boundary.
2Physical objects in the problem can still be of arbitrary shape, but must be enclosed by a sufficiently large virtual sphere
within the computational domain. tup: COMPLETED Click run to continue

2



Post Analysis: computeFarFieldFromKirchhoffBox

* Pick number of points on “Far Sphere” (humPhi and numTheta
* Pick number of times on “Far Sphere” (timeStepStride)

mVSim - Phased Array Antenna - [m} *

File Edit Tools View Help

e Search: computeFarFieldFromKirchhoffBox.py =

Available Analyzers: Open Analyze Stop Clear Output

P annotateSpeciesDataOnPlane.py A Outputs
P | ompareFields.py simulationName phasedArrayAntenna

computeBeam2ModeCoupling.py

Writing phasedArrayAntenna farf 254.vsh5 ~

. fieldLabel E Writing phasedArrayhAntenna_farE_255.vsh§
z  computeCavityG.py Writing phasedArrayAntenna_farE_256.
N [ computeCumulativeSumHistory.
li P y-py farFieldRadius 30 Writing phasedArrayAntenna_farE 257.vshS5
sl computeDebyelength.py - -
& computeEmittanceFromDump.py timeStepStride |21 Writing phasedArrayAntenna farE 258.vshs
Hel computeDielectricModes.py L
. Writing phasedArrayAntenna farE 259.vshS
computeEmittanceOnPlane.py getFourierComponent [0 Writing phasedArrayAntenna_farE_260.vshS
computeFarFieldFromKirchhoffBox.py
Writing phasedArrayAntenna_farE_261.vsh5

computeFarFieldRadiation.py

N frequency 1e9
computeFieldCrossProduct.py Writing phasedArrayAntenna_farE_262.vsh5
computeFieldMaxAmplitude.py

) . numTheta |15 Writing phasedArrayAntenna_farf_263.vsh5
computeFieldRellntensityHilbert.py Writing phasedArrayAntenna farf 264.vsh5
computeGradient.py numPhi 30
computelnverseQ.py Writing phasedArrayAntenna farE 265.vsh5
computeMassFlux.py zeroThetaDirection (0,0,1) Writing phasedArrayAntenna farE 266.vsh5
computePtclBalance.py

tePtell Spect - Writing phasedArrayAntenna farE 267.vsh5
computertclimpactspectrum.py zeroPhiDirection (1,0,0) Writing phasedArrayAntenna_farE_268.vsh5
computePtclLimits.py
omputePtclNumDensit X . Writing phasedArrayAntenna farE 269.vshS
compute um ity.py varyingRadiusMesh 1 - -
computeS11Parameters.py Writing phasedArrayAntenna farE 270.vsh5
computeSParamsFromHists.py simpsenlntegration 0 Writing phasedArrayAntenna_farE_271.vsh5

computeSParamsViaOverlaplntegral. py

computeSpectrogram.py

computeTimeSeriesAmplitude.py Writing phasedArrayAntenna_farE_273.vsh5

) . ] i 1 i

computeTimeSeriesFrequency.py Overwrite Existing Files Writing phasedArrayAntenna_farE_274.vsh5
] Writin hasedArrayAntenna farE 275.vsh5

computeATransntTumeFactor.py The following variables can be used in the above analyzer options: 9 phasedirrayhntenna_tark 2 '

convertFieldComponentCartToCylX.py

$DIR = C:\Users\smithe\Documents\txcorp\VSim10.1\simulations/PhasedArrayExample A || lvs ompleted successfall

$SIMNAME = phasedArrayAntenna v naEmnE mommme e sHmemea v

Import Custom Analyzer L

Writing phasedArrayAntenna_ farE_272.vshS

|convertFieldComponentCartToCylZ. py v

@Analyze: ANALYZER SUCCESS Analyzer finished successfully.. Show Log




Post Analysis Result (farE

* Instantaneous Far Field Pattern, 3D, and Slice

mVSim - Phased Array Antenna
File Edit Tools View Help
Add a Data View

Data Overview @

Variables

VScalar Data
’B
> cylinderOElemUnion
>E
vfark
farE_magnitude
[fare_x
DfarE_y
O farE_z
>)
> phasedArrayAntennaPecShapes
7 Vector Data
> Meshes
> Geometries

[] Log Scale Color
[] pisplay Contours

] clip All Plots Plane Controls

Annotation Level: Axes & Legends

©Visualize: READY Visualization available

Reload Data

3d
Save Image Labels Axis Scale Rendering Colors Reset View [ ] Full Frame [ ] Auto Reset

275

Show Log

mVSim - Phased Array Antenna
File Edit Tools View Help
Add a Data View

Data Overview Field Analysis =

Field farE_magnitude
Slice Settings
0

Clip Plane Control
["] Log Scale Color Table

Lineout Settings
Vertical Horizontal Advanced
L
Intercept: 0
Perform Lineout

Layout: 2d Only

Annotation Level: Axes & Legends

oVisualize: READY Visualization available

ZIntercept .

2d
Save Image Labels | Colors | Reset View D Full meeD Auto Reset

* Main Lobe

Dump: 0

Gra

Reload Data

ting Lobe

275

Show Log




Visualization of Fields (Ez

B VU C 1 n@ssu Ay ArEnna
File Edit Tools View Help
Add a Data View - Reload Data

Data Overview © Field Analysis

* Display
Contours

e Reset Min/Max
to+/-0.1

Variables 3d

Save Image Labels 'Axis Scale Rendering Colors Reset View [ ] Full Frame [ ] Auto Reset
MScalar Data

’B

2 cylinderOElemUnion
4

£ Pseudocolor

S E_magnltude VemEz

X

ey . 0.05000
Ez — 0.0000

vfark
[CfarE_magnitude
[JfarE_x - 000

[JfarE_y Min: -7.360
[Jfa rE_z

>) e
> phasedArrayAntennaPecShapes
>Vector Data
>Meshes
> Geometries

* Time variation
shows beam
changing
direction

[] Log Scale Color
Display Contours
# of Contours: 4 =|

[] clip All Plots Plane Controls

Annotation Level: Axes & Legends - || 0 275

GVisualize: READY Visualization available Show Log




Anticipated Applications

* 5G: Multiple beams / multiple frequencies.

* Optimizing Side Lobes and Grating Lobes.

* Look at cross-talk between nearby arrays on tower.
* Look at near field geometry reflections.

* Look for shadowed regions for indoor installations.



Thank You!

e Questions?



